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Chapter 1. Overview 

Introduction 

The Soil Resource Inventory Toolbox (SRITB) for ArcGIS provides tools and toolbars custom designed to 
improve the ease and efficiency of the soil data collection. 

Installation 

Installation requires Administrative privileges, the previous installation of ArcGIS Desktop suite, and Microsoft 
.NET support for ArcGIS. 

To install the tools, double click the SRITBInstaller.msi file and proceed through the installer by clicking the 
Next button. After installation, you will have several new toolbars in ArcMap and ArcScene and a new 
extension available in ArcMap. The extension must be manually enabled in the Tools->Extensions menu of 
ArcMap by clicking the checkbox next to SRITB. When the extension is enabled, one of the toolbars will be 
displayed whenever a new document is created or opened. The Edit Task selector will be moved from the 
default ArcMap Editor Toolbar to the SRITB - Edit Toolbar. Several context menu options will be added to the 
built-in ArcMap editing context menus to increase editing efficiency. 

Configuration 

Soil Resource Inventory Toolbox can be customized through the preferences dialog. It is accessed through a 
button on the SRITB - Edit Manager toolbar. The SRITB toolbars automatically dock to one side of the screen, 
and can be changed from the default on the left side of the screen to the top, bottom, or right side of the screen 
using he dialogue box. These toolbars can be customized through the normal ArcMap Tools->Customize 
method. They read their initial configuration from a stored preferences file. This file can be customized and then 
distributed as part of a standard configuration for a group of users. If you already have custom toolbars that you 
prefer to continue to use, you can find the various SRITB tools through the customize dialog in the 
DigitalEditing category and place them on your own custom toolbars. Individual tools will work whether or 
not the SRITB Extension is enabled. For more information on the options in the preferences dialog, you can 
click the question mark in the upper right corner and then select your option of interest. More details are also 
available in other sections of this manual describing each individual tool. 

Figure 1.1. SRITB Preferences Button and Dialog 

 

 

Preferences 
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Toolbars 

The Toolbox provides six toolbars designed to maximize the screen space available for editing. Only one toolbar 
will be displayed at a time. It will dock to one side of the screen as specified in the extension's preferences 
dialog. This dialog is available on the SRITB - Edit Manager toolbar by default. You can navigate to any one of 
the toolbars through the drop down menu or cycle through them using the yellow arrow buttons. 

Figure 1.2. SRITB Toolbars Menu and Arrows 

 
The Sketch and Topology toolbars contains a subset of the tools available on the similarly named built-in ESRI 
toolbars. These toolbars are primarily included for the added convenience of accessing them through the SRITB 
toolbar interface. 

SRITB - Edit Manager 

The SRITB - Edit Manager Toolbar contains the standard toolbar-switching tools and table of contents toggle. It 
has tools infrequently used during actual editing. Specific tools found on this toolbar are the SRITB Preferences 
button, start, stop, and save editing commands. These commands are followed by the Snapping Environment 
Toggle and the Snapping Tolerance, Sticky Move Tolerance, and Stream Mode Tolerance quick change 
commands. The toolbar installs with defaults set for snapping tolerance, sticky-move tolerance, and stream 
mode tolerance that are most appropriate for most soil line editing. 

Figure 1.3. SRITB - Edit Manager Toolbar 
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Figure 1.3a. SRITB – Editor Icons 
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Figure 1.3b. SRITB – Tolerance Settings Icons 
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SRITB - Edit Toolbar 

The SRITB - Edit Toolbar contains the tools most commonly used during digital soil mapping. It contains built-
in ArcMap commands for Explode, Edit Attributes, Edit Task and Target Selectors, custom made Streaming 
toggle, Trace Lines tool, and Sketch tool. 

Note 

The Edit Task selector will only appear on the SRITB - Edit Toolbar if the SRITB Extension is 
enabled. This toolbar is also the default location of the custom editing tools which are described in full 
in Chapter 2 – Digital Editing Tools – Section: Custom Tools. Three common topology tools 
are also included on this toolbar: Clear Selected Topology Elements, Validate Topology in Selected 
Area, and Fix Topology Errors. 

 3  



 Overview  

Figure 1.4. SRITB - Edit Toolbar 

 

Figure 1.4a. SRITB - Edit Toolbar Icons 

 

Sketch 

Editing 
Topology 

Editing Tools 

Reshape 
Edge 

Modify 
Edge 

Merge Create 
Island 

Polygon 

Cut 
Polygon 

Auto 
Complete 
Polygon 

Editing Tools 

Streaming 

SRITB - Sketch Toolbar 

The SRITB - Sketch Toolbar contains the most commonly used ESRI Ink tools. 

 

Figure 1.5. SRITB - Sketch Toolbar 
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SRITB - Topology Toolbar 

The SRITB - Topology Toolbar contains the most commonly used ESRI Topology tools. 

Figure 1.6. SRITB - Topology Toolbar 
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SRITB – QC Toolbar 

The SRITB - QC Toolbar contains quality control tools. 

Figure 1.7. SRITB - QC Toolbar 
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SRITB - GPS Toolbar 

The SRITB - GPS Toolbar contains tools designed to help make use of GPS data in the field. The Pedon 
Autopopulation Tools are located on the GPS Toolbar, as well as tools to navigate with GPS and record an 
observation point at the current location. See Chapter 4, GPS Tools, and Chapter 5, Pedon Autopopulation 
Tools, for more information. 

Figure 1.8. SRITB - GPS Toolbar 
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Chapter 2. Digital Editing Tools 

Overview 

The custom designed Digital Editing tools are found mainly on the SRITB - Edit Manager and SRITB - Edit 
Toolbar toolbars. They are designed to save time and reduce the amount of effort required in editing GIS data. If 
you wish to use these tools on other standard ESRI toolbars, the tools can be found in the DigitalEditing 
category of the ArcMap Customize dialog and drag them to your preferred toolbar. 

Editing Environment 

The SRITB toolbars contain several controls to help you change the parameters of your editing environment. 

Table of Contents Toggle 

The Table of Contents Toggle is on each of the SRITB toolbars. It shows and hides the ArcMap table of 
contents when clicked. Unlike regular menu option (Window->Table of Contents), the current map scale is 
maintained when the Table of Contents Toggle is used. 

Figure 2.1. Table of Contents Toggle 

 

Snapping Environment Toggle 

The Snapping Environment Toggle is on the SRITB - Edit Manager toolbar. It shows and hides the ArcMap 
Editor Snapping Environment Panel when clicked. This tool maintains the current map scale when it is toggled 
on and off. 

Figure 2.2. Snapping Environment Toggle 

 

Snapping Distance 

The Snapping Distance quick change panel is accessed from the SRITB - Edit Manager toolbar. You set the 
ArcMap editor snapping distance on this panel instead of loading the ArcMap Editor Options dialog. Enter the 
snapping distance on the left and select units of Pixels or Map Units on the right. The panel will close itself 
once you move the mouse to another task. 

Figure 2.3. Snapping Distance Quick Change Button and Panel 

 

 

 
 

Sticky Move Tolerance 
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The Sticky Move Tolerance quick change panel is accessed from the SRITB - Edit Manager toolbar. ArcMap 
editor Sticky Move Tolerance is set on this panel instead of loading the ArcMap Editor Options dialog. The 
panel closes once the mouse is moved to another task. 

Figure 2.4. Sticky Move Tolerance Quick Change Button and Panel 

 

 

 

Streaming Tolerance 

The Streaming Tolerance quick change panel is accessed from the SRITB - Edit Manager toolbar. ArcMap 
editor Stream Mode Tolerance is set on this panel instead of loading the ArcMap Editor Options dialog. The 
panel closes itself once the mouse is moved to another task. 

Figure 2.5. Streaming Tolerance Quick Change Button and Panel 

 
 

 

Streaming Toggle 

The Streaming Toggle button is found on the SRITB - Edit Toolbar. It provides a convenient way to toggle 
streaming mode on and off. Also, it is a visual indicator showing what mode is currently active. See Figure 2.6, 
“Streaming Mode Toggle - Streaming Mode Off” and Figure 2.7, “Streaming Mode Toggle - Streaming Mode 
On” for examples of how the button looks in either state. 

Figure 2.6. Streaming Mode Toggle - Streaming Mode Off 

 

Figure 2.7. Streaming Mode Toggle - Streaming Mode On 

 

Custom Tools 

The SRITB toolbars contain custom editing tools designed to reduce the number of steps required to complete 
common GIS editing tasks. If there is an active edit session then all the tools will start a new session before 
setting the appropriate edit task. 

Reshape Edge 
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Use of the Reshape Edge tool requires an active topology in the ArcMap session. When the button is clicked, it 
will start an edit session then activate the topology tool, if needed. Click to select the line that needs reshaped. 
Once the line is selected, the edit task will be reset to Reshape Edge and the sketch tool will be activated. Draw 
the sketch to reshape the line and double-click to finish. 

Figure 2.8. Reshape Edge Button 

 

Modify Edge 

Use of the Modify Edge tool requires an active topology in the ArcMap session. When the button is clicked, it 
will start an edit session. Set edit task to Modify Edge then activate the topology edit tool. This tool can be used 
to select and modify edges in the dataset. 

Figure 2.9. Modify Edge Button 

 

Cut Polygon 
The Cut Polygon button will start an edit session and activate the feature selection tool. Click to select the 
polygon that needs split. The tool will detect your selection and activate the cut polygon edit task, and sketch 
tool will draw the cut line. Double-click to finish. After the cut is performed, the tool will perform an explode if 
any of the cut features were multi-part polygons. The default behavior is to show the Edit Attributes window. 
This behavior can be changed in the preferences dialog by unchecking “Display Attribution Window” after “Cut 
Polygon”. See more information in the section in Chapter 1. -  “Configuration”. 

Figure 2.10. Cut Polygon Button 

 

Create Island Polygon 

The Create Island Polygon tool will start an edit session and activate the feature selection tool. It also sets the 
editor snapping properties so that they snap to edit sketch vertices. This allows the creation of an island polygon. 
Click the feature that contains the island to select it. The tool will set the edit task to cut polygon and activate the 
sketch tool. This tool can be used to draw the island polygon. Double click to finish the edit sketch and the tool 
will perform an explode if any multi-part polygons are present. Then the tool will display the edit attributes 
window if the “Display Attribution Window” after “Cut Polygon” is checked in the preferences dialog. It will 
reset the snapping properties to what they were before running the tool. If “Continue Cutting” is checked after 
the “Create Island Polygon” box in the preferences dialog, snapping properties will be reset to what they were 
before running the tool. See more information in the section in Chapter 1 - “Configuration”. 

Figure 2.11. Create Island Polygon Button 

 

Auto Complete Polygon 

Use of the Auto Complete Polygon tool requires an active topology in the ArcMap session. When clicked, the 
button will start an edit session and then set edit task to Auto Complete Polygon. This will activate the sketch 
tool allowing you to add polygons to an existing layer. 
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Figure 2.12. Auto Complete Polygon Button 
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Chapter 3. Quality Control (QC) 
Toolbar 
Figure 3.0 Access the QC Toolbar from the SRITB Edit Manager Toolbar 

 
 
 

The QC Toolbar contains five tools 
• QC Error Inspector (finds and fixes errors) 

• Find minimum size polygons 

• Find common soil boundaries 

• Find label mismatches 

• Find edge mismatches 

Figure 3.1. SRITB - QC Tools 
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QC Extent Button 
QC Extent can show full extent, visible extent, and selected features. When running a task on a smaller area, use 
the selected features option rather than visible extent because it runs faster. 

Figure 3.2. QC Extent Button 

        
 

 
Use:  Select extent prior to using any of the QC tools 

– Full Extent 

– Visible Extent 

– Selected Features 

Find Minimum Sized Polygons 

Figure 3.3. Minimum Sized Polygons Button 

 

 

USE:  Find small polygons to potentially be merged with adjacent 
polygons  

1. Stop Editing Session 

2. Left click on soils layer name in the Table of Contents to highlight (may be a geodatabase featureclass 
or shapefile) 

 
 

3. Click on the Find Minimum Size polygon task icon on toolbar 
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4. Enter a value for area in either acres or sq. meters (You do not need to have an Acres field in the 
attribute table.) 

 

5. Run task 

6. Click on QC error inspector icon to display polygons smaller than specified size 

      

 

7. Left click on a row in the table to select a feature 

 

 

 

8. Right click on the selected row to display options 

9. Select and zoom to a feature using one of the zoom/select options 

 13  



 GPS Toolbar  

 

10. Select Merge to merge selected small polygon with an adjacent polygon if needed. 

11. If the selected polygon is an “island” polygon, it is merged with the surrounding polygon. 

 

12. If the selected polygon is bordered by multiple polygons, an attribute box will appear: 

a) Click on the Object ID in the left pane and the associated polygon will Flash on the screen. 
Click OK. 

b) Select the polygon that has the desired attributes to retain 

If you do not have time to deal with all of the errors in one session, you may save all of the features to a 
shapefile for future reference. 

1. Right click on any record in the QC error inspector table 

2. Select Save All Features to Shapefile 
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3. Navigate to output location and give the new shapefile a name  

4. Save all features to a shapefile. The new shapefile is automatically added to the map document. 

TIP: Once you have finished using one of the QC tools, you should clear all records from the table before 
running another quality control task. 

 

 

If you do not clear the records, they are carried over from one task to another.  The records are cleared out of the 
table when you quit.  The results from multiple tools can cause confusion so it is best to clear the tables after 
each tool is used.  

 

Find Common Soil Boundaries 

 

2. Select extent for task 

– Full Extent 

– Visible Extent 

– Selected Features 

Figure 3.4. Find Common Soil Boundaries Button 

 

 

1. Stop Editing 

 

 

When running a task on a smaller area, use the selected features option rather than visible extent.  It runs much 
faster! 
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3. Left click on soils layer name in the Table of Contents to highlight 

 

Choose the common soil line task icon on toolbar 

 

 

6. Process uses a lot of resources.  Avoid running other processes at the same time 

* Note that features will appear in the error inspector as they are found. Wait until the process is completely 
finished to avoid pro ssing errors 

 soil boundaries 

 

 

8. Left click on a row in the table to select a feature 

 

 

 

 

4. 

5. Wait for message box to appear when task is complete. *Click OK 

ce

7. Click on QC error inspector icon to display polygons with common
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9. Right click on the selected row to display options 

 

10. Select and zoom to a feature using one of the zoom/select options 

 

11. Two Edit Options: 

• Select Merge to merge adjacent polygons if needed 

• Select Edit Attributes to change an attribute if needed 

12. Merge feature 

• When selected, both polygons sharing a common boundary are highlighted 

 

red from table 

user to edit attribute of each selected polygon 

– After merging, one polygon remains and the record is clea

 

 

13. Edit Attributes feature 

– Attributes window opens allowing 
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te in left pane and the polygon will flash 

15. Cha  

. e a name  

18. saved when using the error inspector. 

19. Clear all records from the table before running another quality control task (Rt. Click > Clear All 
Items). 

 

14. Click on polygon attribu

nge the attribute in right pane 

 

16. (Optional) Copy text from find minimum size polygons task. Export out All of the Errors to a 
Featureclass or shapefile. 

• Right click on any record in the error inspector table 

• Select Save All Features to Shapefile 

 

17 Navigate to output location and give the new shapefil

Save Edits.  Edits are not automatically 
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Fin
Fig

 

feature classes to map 

lbar 

3. Select:  Search symbol, Survey Sub-Areas, and Error Tolerance from drop downs 

 

5. Left click on a row of identified polygons to zoom to and select 

d Label Mismatches 
ure 3.5. Find Label Mismatches Button 

 

1. Add adjacent shapefiles or 

2. Click LM task icon on too

 

4. Click Search button 

6. Right click on row to open Replace Symbol options 
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7. Select symbol to change from drop-down list 

 

8. Enter New Symbol, click OK 

 

9. Change is saved automatically, no undo! 

ismatches are found 

 

atches  

 

10. Run label mismatch task again after editing labels 

11. Switch Sub-Area 1 and Sub-Area 2 to ensure all label m

 

 

 

Find Survey Sub-Area Edge Mism

Figure 3.6. Find Survey Sub-Area Edge Matches Button 
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1. Add adjacent shapefiles or feature classes to map 

2. Click EM task icon on toolbar 

 from drop downs 

 

 

 

7. Run edge mismatch task again after editing polygons 

8. Switch Sub-Area 1 and Sub-Area 2 to ensure all edge mismatches are found 

 

 

 

3. Select:  Search symbol, Survey Sub-Areas, and Error Tolerance

4. Click Search button 

5. Left click on identified polygons to zoom to and select 

6. Use appropriate editing tools to match edges 
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Chapter 4. GPS Tools 

GPS Connection Parameters 

This button brings up the ArcMap GPS Connection Setup screen. Use “Detect GPS Port” button and “Test 
Connection”. If both of these buttons are successful, click OK to close the dialog. If one or both fails, manually 
select connection parameters until the “Test Connection” button is successful. 

A communication port of  COM3 and Baud Rate of 4800  is common for some built in GPS receivers.  The com 
ports that ArcGIS selects will generally range from 1 to 9.  Typically ArcGIS will choose the same port over and 
over again on a particular computer. 

igure 4.1. GPS Connection Parameters Button and Dialog F

 

 

 

Activate GPS 

If the GPS is connected and the connection parameters are properly set (see the section called “GPS Connection 
Parameters”), click this button to activate the GPS and display the current location on the map. 

Figure 4.2. Activate GPS Button 
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Display GPS Info 

This button brings up a panel showing detailed information coming directly from the GPS. 

Figure 4.3. Display GPS Info Button and Info Panel 

 

 

Navigate Using GPS 

This tool brings up a window to show the current map. To navigate to a specific place on the map, click on the 
map to place a MARK. The window will show the distance and the bearing to the mark from the current GPS 
location, as well as a compass showing the direction of travel. Click “Go To Next MARK” to clear the mark 
from the map to place another MARK. 

Figure 4.4. GPS Navigation Tool Button and Window 
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Collect a GPS Observation Point 

is tool creates a new point feature using the current GPS location. The point is stored in the first layer in the 
r name. Click the Offset button to enter a distance and bearing to offset the 
 button to link the new point to an external file (picture, video, sound, etc...) 

ave it. 

d Dialog 

Th
ArcMap session with _op in the laye
current location. Click the Hyperlink
with ArcMap's hyperlink tool. After entering the point's information, click Store Feature to s

Figure 4.5. Collect GPS Observation Point Button an
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Chapter 5. Pedon Autopopulation 

The Pedon Autopopulation Tools are designed to automatically fill out location and site data using geospatial 
layers. It also integrates with a GPS if one is available. A user can specify a location or a group of points in 
ArcMa e location is intersected with various data layers on the user's computer to gather data to insert into 

e pedon database. 

Setup 

In order to use the Autopopulation Tools, the following software needs to be installed: 

• Microsoft Access 2003 

• Pedon PC 

The Autopopulation Tools can be found on the Pedon Autopopulation Toolbar or the SRITB - GPS Toolbar. 
Autopopulation uses specifically named layers in the ArcMap document to gather data. The following table list 
layer names and attribute fields currently used. If any of these layers do not exist, the Autopopulation Tools will 
not be able to populate the corresponding items in the pedon database. 

Table 5.1. Pedon Autopopulation Data Layers 

 
Pedon Field Layer Name Attribute Field Name 

Tools 

Introduction 

p. Th
th

Area Overlap - Non MLRA SSA soilmu_a areasymbol 
Area Overlap - State c ty_dm_a STATE_FIPS oun
Area Overlap - County county_dm_a COUNTY_NAM 

Area Overlap - 7.5 Min Quadrangle quads24K QUADNAME 

Area Overlap - MLRA mlra MLRA_NAME 

 
 

When creating new pedons, the Autopopulation Tools will create a new point in your spatial data as well as the 
new Pedon database records. This spatial point will be created in a layer with _dp in the name. It will have the 
new pedon's user pedon ID recorded in an attribute field named user_pedon_id. The user site ID is recorded as 
user_site_id if those fields exist. If this layer does not exist, no spatial record will be created, but new pedon's 
coordinates will still be recorded in the pedon database. 

Usage 

There are two modes of operation: Create New Pedon and Update Existing Pedon. Either mode requires the user 
to specify a user pedon ID. In new mode, the pedon will be created if there is no existing upedonid matching the 
user-supplied one and displaying an error message if it already exists. Update mode is exactly the reverse. It will 
autopopulate existing pedons and display an error message if the supplied upedonid cannot be found in the 
pedon database. 

Pedon PC Autopopulation has three interface modes. GPS mode will use the current GPS position to 
autopopulate. Selected Points mode autopopulates multiple pedons at once using a selected set of points from 
ArcMap. The third method is an ArcMap tool allowing the user to click on the map to autopopulate at the 
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clicked coordinates. 

 

GPS Mode 

In this mode, a connection must first be established to the GPS. Load the GPS toolbar in ArcMap. Open the 
GPS Connection Setup menu and use the Detect GPS Port button followed by the Test Connection button. If the 
connection test fails, modify the settings using the dropdown menus until it succeeds. Click the Open 

ton on the GPS toolbar. 

utopopulation with the GPS, click the Autopopulate from GPS icon in the Pedon Autopopulation 
te ID field unchanged or 

 

, there should be a layer in the ArcMap document with the text _dp in its name and 
a ed user_pedon_id and user_site_id. The user pedon ID supplied will be written to the 

 field, and the user site ID written to user_site_id. The tool will write the 

his method is useful for populating a large group of points. Waypoints can be downloaded from the GPS into 
ArcMap using DN  then pedons can be cr lected set o select 

 layer in ArcM nction will not ts to the documentation 
tion in the futu ol scrolls throug te fields of the selected 

dropdown menu listing the d containin  user site IDs for the 
ill write the same data i ed in the G  and start Pedon 

 

hoose the click tool. Click a location on the map to create a point. 

This method creates a point. There should always be a layer in the ArcMap document with the text  in its 

After it is finished writing data, the tool will launch Pedon PC to allow the user to enter a description for the 

Connection but

To start the a
Toolbar. It will prompt you for a user pedon ID and user site ID. Leaving the user si
blank will result in the user pedon ID being used for the user site ID as well.

This method creates a point
ttribute fields nam

new point's user_pedon_id
latitude/longitude and UTM data. If there are any of the layers found in Table 4.1 “Pedon Autopopulation Data 
Layers,” that data will be written to the area overlap table. 

After it is finished writing, the data tool will launch Pedon PC to allow the entering of a description for the new 
pedon. 

Selected Points Mode 

T
RGarmin and eated from a se f them. To use the tool, 

one or more points from any data
points layer, but that will be an op

ap. This fu
re. This to

add the poin
h the attribu

points and displays a m. Select a fiel g text to use as
new pedons. The tool w tems as describ PS Method section
PC. 

Click Tool Mode
C

_dp

name and attribute fields named user_pedon_id and user_site_id. The user pedon ID supplied will be 
written to the new point's user_pedon_id field, and the user site ID written to user_site_id. The tool will 
write the latitude/longitude and UTM data. If there are any of the layers found in Table 4.1 “Pedon 
Autopopulation Data Layers,” that data will be written to the area overlap table. 

new pedon. 
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Chapter 6. 3D Data View 

Introduction 

The 3D Data View tool is designed to clip layers in ArcMap and send them to ArcScene. 

Setup 

 3D Data View Tool, the Soil Resource Inventory Toolbox Extension for ArcGIS 9.2 version 

” toolbar 

In order to use the
1.1.18 must be installed: 

To add the “3D Data View toolbar to Arc Map, choose View > Toolbars and check the 3D Data View choice. 

Figure 6.1. Select the “3D Data View

 

Use of the 3D Data View Tool 
 
This example presents the ap
unit polygons, DOQ image, 1

plication of this tool in an ArcMap session with elevation survey points, soil map 
0m NED ESRI Grid. 

 

 

 
 
 
 
 
 
 

Soil map units are symbolized with hollow fill and yellow outlines. 
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Figure 6.2. Adjust the display to the area of interest to be displayed in ArcScene 

 

Figure 6.3. Choose the 3D Data View tool. 

 

Figure 6.4. Select the layers to be displayed in the 3D Data View. 

 

One at a time, select the layers from the list of layers in the TOC (table of contents) and click the “Add Layer 
>” button, or hold the shift key down to select more than one layer to add at one time. 

nce the layers have been selected, click on the “View 3D Data” button. 

rc Scene will automatically activate. 

he layers will be added with the existing symbology present in ArcMap. 

he elevation layer will automatically be turned off. 

he image layer will automatically be set to rendering level of 10. 

>

O

A

T

T

T
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Figure 6.5. This is an example of an image ported to ArcScene via the “3D Data View” 
Tool. 

 

Figure 6.6. Set the base height 

 

 

To set the base height, the elevation layer must be selected first by highlighting it.  Then, click on the button that 
pon the size and complexity of the sets the 3D properties.  This process can take a minute or two depending u

layer. 
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Figure 6.7. Results of the base height being set 

 

Figure 6.8. The next step is to set the Vertical Exaggeration. 

 

The button on the right sets the vertical exaggeration. 

Figure 6.9. Choose the Vertical Exaggeration from the drop down menu. 
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Figure 6.10. Zoom in or fly into the scene to view features and imagery draped on the 
elevation surface. 

 
 
When completed with 3D view, close ArcScene application without saving the document.  
This automatically deletes all files created except the clipped elevation data.   
When the tool is activated in ArcMap again, this temporary elevation data stored in the 
C:\temp\Launch3DView folder will be deleted. 
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Chapter 7. ND83 – WG84 Buttons 

 
 
The Convert2Nad83 Tool looks at the Microsoft Access pedon.mdb site table for lat/long, 
datum and UTM values. It then converts Nad1927 values to the NAD1983 datum and outputs 
lat/long decimal degree values in the SiteNad83 Pedon PC database table.  Rows that cannot 
be converted are reported in a text document – “incompletesiteids.txt”. 

Figure 7.1. Pedon Autopopulation Toolbar with ND83 and WG84 Buttons 

 

 
 

Usage 
 
The steps to use the Convert2Nad83 Tool are as follows: 
 

1. Open ESRI ArcMap application. 

Introduction

2. Go to the Tools menu and click on Customize option. 
3. Check the Pedon Autopopulation Toolbar if it is not already checked. 
4. Click the  icon on the toolbar. 

 
Unless the SiteNad83 table is already full, there will be a progress bar on the bottom left 
orner of the ArcMap window. After the progress bar hits 100%, there will be a confirmation 
essage, “Nad83 Transfer/Conversion complete”. 

rogram Functionality 

he SiteNad83 and SiteWGS84 output tables have four fields: siteid, Latitude, Longitude and 
escription. The siteid field is the imported site table primary key field. The Latitude and 
ongitude fields are the lat/long values displayed in decimal degrees. The description field 
ontains a code from 0 to 5 indicating the conversion type. 

 
Documentation of the codes generated to populate the incompleteSiteIDs report that results 
from running the Convert2Nad83 Tool are as follows:  
 
Code 0 
If the site table record has lat/long values and a datum value equal to Nad83, then the code 
“0” is returned in the SiteNad83 table description field. This code reflects no conversion 
performed. 
 
 

c
m
 

P
 
T
d
L
c
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Code 1 
 is Nad27), 
e 

 the site table datum field is empty or one of the lat/long values is empty, then the UTM 
 

Code 3 
are checked. 

 the lat/long values are available, then they are used to calculate the UTM Zone. If the UTM 
asting and Northing values are also available, then they are used to do the conversion. The 

e SiteNad83 table description field. 

 only the lat/long values are available, then the datum is calculated using the site obs table 
tion date field. If the year designation is greater than or equal to “1983” then 
umed, otherwise Nad27 is assumed. The code “4” is returned in the SiteNad83 

ble description field if Nad83 is assumed. The code “5” is returned in the SiteNad83 table 

If th able for the conversion, a text file with the default 
nam ove are included in the report. 
 
Sa b

able 6.1. Site Table 

If the site table record has lat/long values and a datum value not equal to Nad83 (it
then the data is converted to Nad83. The code “1” is returned in the SiteNad83 tabl
description field. 
 
Code 2 
If
values (UTM Zone, UTM Northing and UTM Easting) are checked. If the UTM values are
available, then they are used to do the conversion. The code “2” is returned in the SiteNad83 
table description field. 
 

If the site table datum and UTM Zone fields are empty, then the lat/long values 
If
E
code “3” is returned in th
 
Code 4 and Code 5 
If
site observa
Nad83 is ass
ta
description field if Nad27 is assumed. 
 

ere was insufficient information avail
e “incompleteSiteIDs” is generated and the codes listed ab

mple Ta les 
 
Shown below are the site and site observation tables in the pedon.mdb database and the Site 
Nad 83 table in the pedon_pc.mdb database. 

T
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Table 6.2. Site Observation Table 

 

 
 
 
 

Table 6.3. Site NAD-83 Table 

 
 
 
WG84 Button 
 
The WG84 button works similar to the ND83 button.  It is provided for regions of the 
lobe outside of North America for which WGS84 is a more appropriate datum to 

 

g
use. 
 

 34  


	Cover
	Table of Contents
	Chapter 1. Overview
	Introduction
	Installation
	Configuration
	Toolbars

	Chapter 2. Digital Editing Tools
	Overview
	Editing Environment
	Custom Tools

	Chapter 3. Quality Control (QC) Toolbar
	Chapter 4. GPS Tools
	GPS Connection Parameters
	Activate GPS
	Display GPS Info
	Navigate Using GPS
	Collect a GPS Observation Point

	Chapter 5. Pedon Autopopulation Tools
	Introduction
	Setup
	Usage

	Chapter 6. 3D Data View
	Introduction
	Setup
	Use of the 3D Data View Tool

	Chapter 7. ND83 – WG84 Buttons
	Introduction
	Usage
	Program Functionality
	Sample Tables
	WG84 Button




